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IMPORTANT NOTES!! 

Please note the following before continuing! 

In this version we added more options to the System Settings. 

The following list is new options that are disabled by default (Previously they were always 

enabled); this is relevant for new shows and saved shows from previous software versions: 

 The Remote Control is now DISABLED by default. See Remote Control Enable / 
Disable 

 SMPTE and MTC new buttons are DISABLED by default. Any external trigger (SMPTE 

or MIDI Time Code) will be ignored unless you enable the relevant SMPTE or MIDI 

Time Code button. See SMPTE Midi Enable / Disable  

 “Activate Snap On Load” is DISABLED by default. Saved shows from previous 

versions will be loaded to the default setting. See Vector Snap Enhancements 

We recommend using 2GB of RAM for better performance while 

using this version on Vector PC. (3.19) 
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Version Highlights 

In this version we added more than 40 new devices and updated 80: 

1. Display  

1.1. View Properties Button  

 

A new View Properties button was added to 

the pane title of any grid or soft key view:   

 

1.2. Master PB Indication Enhancement The Playback key on the Faders Mode can be 

used to display the Master PB on the Faders 

Mode LCD. 

1.3. Clock and Date View A Digital and Analog clock was added 

together with a Date view. 

2. Matrix  

2.1. Live Matrix Zoom Function You now have full zoom function control 

while in Live view; Zoom in/out and Fit To 

Screen. These controls are found on the pane 

title of the Matrix programmer live view. 

2.2. Increased Matrix Width / Height in 
the Patch manager 

The Matrix width or Height can now be 

increased to 10,000.  The max cells 

width/height is still 40,000. 

2.3. Clear Selection A Clear Selection button was added to the 

Matrix Programmer. Now you can clear a 

selection by a click of a button: 

  

See Vector Reference Guide;  

Chapter 11, Page 292 on how to display the 
Matrix programmer. 

3. Editing  

3.1. Vector @ Key Enhancement This enables only the dimmer intensity 

parameter value to be affected each time you 

use the @ Key. 
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3.2. Fan Enhancements 

3.2.1. Fan From Step to Step 

 You are now able to activate the Fan 

mode by selecting the Fixture’s, then 

pressing the Fan key. 

 Now you can change a range of 

Fixtures while in Fan mode. 

 You can Fan from one step to another 

using the Step Picker (Color Wheel 

Picker, Gobo Picker and Media Server 

Picker etc.) 

 Now you are able to go from value to 

value using a shorter sequence. 

3.3. Prohibit Mark Cue Vector will now protect Mark cues from being 

manipulated. However you can still edit the 

timing properties and the name of the mark 

cue.  

3.4. Move Function  The Move function enables you to 

move objects such as cue’s, groups, 

libraries etc.  

 More sequences where added for Copy 

and Cut in Enter Mode Syntax. 

3.5. Effect Editor Improvements 

 

 

 

 Now you can assign an exact value 

using the keypad. 

 The Release button has been 

enhanced. 

 A Pre Build effect can now be run on 

parameters of the same type, example; 

RGB 

4. Playback  

4.1. Direct PB operations You are now able to do PB operations, for 

example; assign Qlists, release PB’s etc., 

directly from the PB wing view.  

4.2. Vector Snap Enhancements A new option was added that enables you to 

choose if the PB will be released or activated 

when loading a show, for example; “Activate 

the snap on load”.   

 



Version Highlights  

     | 4 

5. Patch Manager  

5.1. Apply and Continue Wizard Now you are able to apply a patch and 

continue working in the same wizard dialog 

without re-opening the wizard after every 

operation. 

6. System Settings  

6.1. SMPTE Midi Enable / Disable  You now have the ability to control 

the signals from SMPTE, MTC, MIDI 

In and MIDI Out. 

 A larger clock view was added to the 

active TimeLine view screen.  

6.2. Remote Control Enable / Disable 

 

 

 

A Remote Control Application’s option was 

added to allow you to enable or disable the 

ability for an external application to connect 

to the console. This option can be found in the 

Network tab: 

Tools ► System Settings ► Network 

The Remote Control Application’s option is 

DISABLED by default. Enable the option so 

that an external application can connect. 

(iControl, iControl App & Remote PC Panel). 

 

 

You will still be able to see the console in 
the console list on the remote application, 
however, the console will NOT respond 
until you ENABLE the remote control in 
that console. 

Note: External hardware (Editor, 

Playback and Channel wing), can still be 

connected to the console if the Remote 

Control Application’s option is either enabled 

or disabled. 
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7. Desktop  

7.1. Desktop Enhancements  A bunch of new desktop enhancements where 

added: 

 Stage Element support: 

There are 16 elements that can be 

dragged onto the Desktop. Each 

element can be manipulated to change 

size, angel, line thickness and line 

color. 

 Ability to add shortcuts from the 

windows explore to the desktop. 

 Printing ability 

 Undo changes  

 A new Layers Toolbar that enables 

you to define layers, lock layers and 

decide which layers you want to 

display. 

8. General Improvements  

8.1. Export Show to ASCII Vector now supports ASCII show file export 

according to the ASCII Standard Protocol.  

8.2. Import ASCII Show File Enhanced Import ASCII Show file now supports: 

 Proportional Patch Level 

 Cue Link 

8.3. WIN SCROLL Mode Enhancements 6 new functions where added to the WIN 

SCROLL mode. 

8.4. Locked Columns Enhancement  A thicker and brighter line can now be seen 

when you lock columns on a grid view. 

8.5. Blind Enhancements It is now possible to copy the editor values 

into the Blind editor. 

8.6. Import Devices Improvements You are now able to select multiple devices 

from the Import Device tree as you would in 

windows.(CTRL or SHIFT) 
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8.7. Delete / Clear Patch in reverse 
order 

Now you can delete or clear a patch in reverse 

order in the Clear Patch dialog from the Patch 

manager. 

 

8.8. VC Compressed Indication When you use VC Compressed, the indication 

bar will now indicate VC’c. 

 

8.9. Workspace Improvement Now if you have only one workspace, there 

will be no workspace indication tab until you 

add another workspace. This helps save 

screen space. See Workspace example.  

8.10. Range Information The Modify or patch dialog title bar now 

contains range information. 

See Modify and Patch Information 

Improvement. 

8.11. Import / Export shows Enhanced 
Menu 

The new Import / Export Show’s menu now 

contains all the Import and Export show 

options: 

 Import Partial Show 

 Import 4D Show 

 Import Sabre Show 

 Import ASCII Show 

 Export Show To ASCII 

8.12. Using PB in Cut Time  You are now able to manipulate PB content 

by using the [SHIFT] key together with a PB 

key. 
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Bug Fixes – Vector Software 3.19.R01 

1. When using DMX input on Fixtures with high Fixture numbers (example; 1000), after 

loading that show, the DMX input was deleted. This has been fixed. Thanks Bill Peachment, 

Little Mouse Production, David Bishop & Ian Reith, UK.  

2. The column order of the DMX Port view was misleading. Now the first field is the Fixture 

name. Thanks to Alone Cohen, Israel 

3. If a text of a “point cue” contained zero at the end, the text did not show on the SK view. 

This has been fixed now. Thanks Raphael Ollier, Crystal Equipment, France and our French 

distributor and his clients.  

4. Pressing again on an enabled button in the pre-built tab was not possible. When the PB 

definition was enabled (in the system settings), and you were working in main master Qlist 

mode, [STORE, CUE, SELECT] was not using the single cue definition.  

5. When a PB fader behavior was X-Fader and the fader was at zero position, raising the fader 

after [Qlist, #, Cue, #, SELECT] did not work the first, but worked the second time. If the 

fader is at full position it must be taken down and then up again. This has been fixed. Thanks 

to Gino De-Leo, Spotlight and RAI TV, Italy.  

6. [FIXTURE, #, FULL/ON/ZERO] on an RGB Fixture with a virtual dimmer was not possible.  

7. When a RGB device had a Dimmer parameter and you stored cues on a fader that was set as 

intensity, taking down the fader also took down the RGB values. This is now fixed. Thanks 

Bill Peachment & Ian Rieth, UK.  

8. When fanning values with [90% →10], the spread negative was activated and if pressed 

again the data changes where incorrectly calculated. This has been fixed.   

9. When using HOME or RELEASE key while in REM Dim mode, kicked you out of the 

mode. This is now fixed. Thanks David Winnik (Vini), Israel.  

10. When examining an A/B or PB that was active, the console showed the preview instead of 

the Exam tab. This has been fixed. Thanks Sabi at House of Tradition (MUPA), Hungry.  

11. When using the blackout key, or grand master, the "fine" parameter of the 16 Bit dimmer did 

not change to 0% and therefore the console did not black-out. This is now fixed. Thanks 

David Bishop, David Bishop Lighting, UK.  

13.  [UPDATE, Cue Only] on a cue before a mark cue or a force black cue, was ignoring the cue 

only function. This has been fixed. Thanks Orit freedman, BEO, Netherlands.  
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Operating New Features 

 

ATTENTION! 

 

This Vector documentation contains both Action and Enter procedure syntax. Procedures that 

use Action syntax are preceded by:  procedures that use Enter syntax are preceded by:  

 

 

Limitations 

 When dimming desk lights, FULL, ON, or ZR will only work after the Wheel has been 

moved.  

 Beat is not implemented yet.  

 In Try Cue, the parameter time progress will not displayed.  

 Qlist and Cue cannot be set as the Numeric default in the Command line.  

 Interactive Fixture selection does not work on a console designated for slave or node.  

 Matrix and Topo selection does not work on a console designated for slave or node.  

 Cue numbers in Qlists on time-lines will not be updated when re-numbering Cues.   

**Work around: Re-number before teaching the time-line.  
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The View Properties Button 

The View Properties button which replaces the Soft Key editor button enables you to change 

properties according to the view type on any soft key or grid views. The View Properties option 

can be accessed from; the pane title, right click menu or View menu ► View Properties.  

For example:  

To change the SK view properties  

 Click on the View Properties button on the SK view pane title bar.  

-OR- 

 Right click, select View Properties. 

-OR- 

 From the View menu select View Properties. 

 

  

To change the Grid view properties 

 Click on the View Properties button on the Grid view pane title bar. 

-OR- 

 Right click, select View Properties. 

-OR- 

 From the View menu select View Properties. 

 

View Properties 

button on the 

pane title 

View Properties 

button 
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Clock and Date View 

The Clocks and Date view options have been added to the Workspace tree ► Editor Tool’s ► 

System Time: 

  

 

 

 

 

 

 

 

 

To add a clock or date 

 From the Workspace Tree, click on System Time; choose a clock or date or both.  

(Each one will be in a separate tab view) 

 

Each clock and date view will be resized automatically when you change the tab size. By double 

clicking on the actual clock or date will bring up the PC’s Date and Time Properties box: 
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Master PB Indication on the Faders Mode LCD 

By pressing and holding down the Playback key on the Faders Mode, will display the Master PB 

in the Faders Mode LCD. This feature works for all Vector models. 

  

 

 

 

 

 

 

 

 

 

 

 

Faders Mode LCD displaying 

the Master PB 
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Vector @ Key Enhancement 

A new button has been added to the System Settings ► Editing tab, called “@ Key For 

Intensity Only”: 

 

 

When the @ Key For Intensity Only is enabled, only the dimmer intensity parameter value will 

be affected each time you use the @ Key. The keys; ZERO, FULL and ON will also default to the 

intensity parameter, not to the last selected parameter. 

You can also use ZERO, FULL and ON for parameters but only if the parameter key is pressed 

directly before you press ZERO, FULL or ON. 

The @ Key For Intensity Only is saved in the show data, so you can decide if to enable it per 

show. 

 

NOTE: Old shows will be loaded with the @ Key For Intensity Only disabled. 
 

When the @ Key For Intensity Only is enabled, you are also able to select and change multiple 

parameters by using the following sequences: 

 [Param, Param, enter value] 

 [Param, Param, FULL/ON/ZERO] 

 

If the @ Key For Intensity Only is disabled, then the last selected parameter will be affected by 

the @ Key, (Which is how it has always worked)  

 

 

NOTE: Decimal value input [SHIFT+@], is not affected by the @ Key For Intensity Only 

function key. 

 

 

 

 

 

 

New added key to 

the Editing tab 
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Examples: 

When the @Key For Intensity Only is disabled: 

Sequence: 

1. Select a FIXTURE, example; Spot 1. 

2. Select a parameter, example; Cyan. 

3. Press the @ key and enter a value using the keypad, example; 75.  

The Cyan parameter will be changed to value 75. 

 

 

When the @Key For Intensity Only is enabled: 

Sequence 1: 

1. Select a FIXTURE, example; Spot 1. 

2. Select a parameter, example; Cyan.  

3. Press the @ key. (Once you press the @ key the parameter selection will automatically 
change to the dimmer intensity parameter).  

4. Enter a value using the keypad, example 75.  

The dimmer intensity parameter value will be changed to 75 without Cyan being 
changed. 

 

 

Sequence 2: - Selecting multiple parameters:   

1. Select a FIXTURE, example; Spot 1. 

2. Press the @ key. 

3. Select parameter, parameter, enter a value, example: 

[Cyan, Magenta, 45] 

-OR- 

1. Select a FIXTURE, example; Spot 1. 

2. Press the @ key. 

3. Select parameter, parameter, enter a value, example: 

[Cyan, Magenta, FULL] 
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When the @ Key For Intensity Only is enabled or disabled 

Sequence 1: 

This sequence will work regardless if the @ Key For Intensity Only is enabled or disabled. 

1. Select a FIXTURE, example; Spot 1. 

2. Select a parameter, example; Cyan.  

3. Enter a value using the keypad, example 75.  

The Cyan parameter will be changed to value 75.  
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Fan Enhancements 

The new Fan enhancement gives you a faster way of using the Fan feature without exiting the 

Fan mode. You are now able to activate the Fan mode by selecting the Fixture’s, then pressing 

the Fan key, and then selecting a parameter, or you can use the previous sequence of activating 

the Fan feature [Fixture # → # select parameter, FAN]. 

A new soft-key attribute has also been added to the Fan Toolbar which is the Fan Inward Mirror 

button: 

 

 

 

The Fan Inward Mirror key 

The Fan Inward Mirror button enables you to fan from the outside to the center. The Fan 

Inward Mirror button is the opposite of the Fan Outward Mirror button . 

 

Using the new Fan Mode 

When you are in Fan mode, the Fan key LED will be lit and the command line will display 

[FAN] together with the current selected Fan parameter, for example: 

 

 

As soon as a parameter key is pressed or a parameter wheel is moved, the indication on the 

command line will show [FAN_*_], indicating that a parameter is in active Fan mode. 

 

 

When using the new sequence of activating the Fan [Fixture # → #, Fan], the last used Fan 

parameter will be selected. (The default Fan parameter is Fan Center Diagonal). 

 

 

 

NOTE: When using the previous sequence, [Fixture # → # @ # → #], out of the Fan 

mode, the default fan direction will still be the Fan Side Right button. 

 

Fan Inward Mirror key 

Last selected Fan parameter 
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After the Fan feature is activated using the sequence [Fixture # → #, Fan], you are then able to 

select a parameter, such as yellow, and then Fan it using the wheel of that parameter.  

After selecting a fan option, the system will always default back to the last used fan option until 

you select a different fan type or reboot the console. 

Example: 

If you are using the Fan Side Left option to fan spots 1-5, then you select spots 6-10, the 

minute you press the Fan key the system will default to the last used fan option which 

was the Fan Side Left option. 

When you select a parameter to fan, the fan will stay on that parameter until you select another 

parameter, in which case you will need to press the Fan key again to activate the fan for that 

parameter.  

Example: 

If you have selected the Cyan parameter to fan, and then you select the Magenta 

parameter to fan, the minute you select the Magenta parameter the console will exit the 

fan mode until you press the Fan key again. 

  

To exit the Fan mode 

 Press either Fan, ENTER (in ENTER Mode), Clear or Reset. 

The Fan key LED will turn OFF and [FAN] will disappear from the command line. 

 

Fan mode sequences 

These are the sequences that can be used to activate the Fan mode: 

 Select Fixtures, FAN, then adjust fan with a parameter wheel. 

 Select Fixtures, Select parameter, FAN, then adjust fan with the selected parameter 

wheel. 

 [Fixture # → #, @, # → #] 

 [Fixture # → #, Select a parameter, # → #] 

 [Fixture # → #, FAN, @, # → #] 

 [Fixture # → #, FAN, Select a parameter, # → #] 

 Using the Step Picker [Fixture # → # STEP → STEP]. See Fan Parameter from Step to 

Step. 

 Using the Media Server Picker [Fixture # → # STEP → STEP]. See Fan Parameter from 

Step to Step. 
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 We also added a sequence to make it easier to go from: 

 Value to value to value etc.: 

[Fixture # → #, @, # → # → # → # → # → # → #...etc. etc] 

-OR- 

 Using the Step Picker: 

[Fixture # → #, STEP → STEP → STEP → STEP…etc] 

  

NOTE: You can change the Fixture selection while in fan mode as long you keep 

working on the same parameter. 
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Fan Parameter from Step to Step 

This new features enables you to Fan from one step to another using the Step Picker (Color 

Wheel Picker, Gobo Picker and Media Server Picker etc.) 

 

Using the Step to Step Fan Feature 

The Step to Step Fan feature is now similar to the sequence of value to value: 

[Fixture, # →# @ # →#] 

You are now able to use the same sequence using Steps from a Picker. This sequence can be 

used whether you are in Fan mode or not. 

For example; 

1. Select a range of Fixtures. 

2. Open a picker from a parameter, for example; double tap on color wheel to open the color 

wheel picker. 

3. From the picker, tap on a step, for example; Red. 

4. Press on the “Thru” key →. 

The console will now enter into Fan mode. 

5. From the picker, tap on another step, for example; Orange. 

The selected range of Fixtures is now fanned from Red to Orange. 

6. Repeat point 4 – 5, to carry on fanning from step to step. 

 

Tip! You can change the Fan attributes from the Fan toolbar. 

 

Note the following: 

When you Fan using pickers, if the Fixtures in the selected range are from 

different device types, the Fan will be from the start point of the step you choose 

from the active picker, until the end step you choose from the active picker. This 

will actually spread the result values of that parameter type to all the active 

devices.  

Example; If you work with VL3000 Spot and Mac III Spot, assigning values to 

both of these Fixtures range from the color wheel picker of the VL, from step 2 

(24%, Orange) to step 7 (72%, Deep Red), the values of the Fan on the whole 

range will be fixture 1 color wheel at 24% until the last fixture at level of 72%, 

This will happen even though the actual step value and content on either of the 

device type are not necessarily a Deep Red color but the device value of the color 

wheel at 72%. 
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Prohibit Mark Cue Data Modifications 

You are now prohibited from editing the Mark Cue, except the timing properties and the name of 

the mark cue. If you try to update, overwrite or store on an existing mark cue, the console will 

prompt you with “Mark cue cannot be edited”. You are still able to delete a mark cue. 

If a mark cue already exists and you try to re-store the mark cue, then the console will prompt 

you with “Object Exists” together with an option to “Overwrite”. 

 

Updating an Active Mark Cue 

If a Mark cue is active on the PB and you update that mark cue using the Update dialog 

[Update], the command line will show the error message “MARK CUE CAN NOT BE EDITED” 

and the Update dialog will open. The Update dialog will show the Cue before the Mark cue that 

you are trying to update. You will now have the option to update the cue before the Mark cue or 

update a different cue. 

Example: 

1. [Spot 1-10, HOME, Channel 1-10, @ 50%, Cue 1, Store] 

2. [Spot 1-10, ZERO, Cue 2, Store] 

3. [Spot 1-10, FL, Pan Tilt changes, Cue 3, Store] 

4. [Cue 2.5, Mark Cue, Store] 

5. Go to cue 2 on the PB, the console will automatically fade to the mark cue (2.5) 

6. [Channel 1- 10, @ 80%, Update] 

The Update dialog will open showing Cue 2 (which is the cue before the Mark cue) and 

the Command line will indicate “MARK CUE CAN NOT BE EDITED”: 
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The Move Function 

The Move function enables you to move objects such as cue’s, groups, libraries etc. This is a 

faster and easier way without using the cut and paste functions. We also enhanced the Copy and 

Cut sequences to work in Enter mode. (Meaning now you can start with an action, e.g. [Copy]) 

 

Sequences to move objects 

The following sequences are used to move objects by either using the keypad or soft keys. These 

sequences can also be used with Copy and CUT. 

 

To move an object using the keypad 

1. [SHIFT + MOVE] 

2. Press on the object key that you want to move, e.g. [Group], [Qlist] etc. 

3. Type in the object number that you want to move. 

4. Press @ key.  

5. Enter in the target number (The place number to move the object to) 

 

6.  [Store]  

-OR- 

 

7. [ENTER] / [Store] 

 Example: 

In this example we will move Group 1 to Group 10: 

1. [SHIFT + Move] 

2. Press [Group] and type 1 on the keypad. 

The command line will indicate the following: 

 

3. Press the [@] key.  

The command line will indicate the following: 

 

4. Enter target number 10 

5. Press [Store] / [ENTER] 

The command line will indicate the following: 
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To move a range of objects using the keypad 

1. [SHIFT + MOVE] 

2. Press on the object key that you want to move, e.g. [Group], [Qlist] etc. 

3. Select the range [# → #] 

4. Press [@] key.  

5. Enter in the target number. (The place number to move the object to) 

 

6. [Store] 

-OR- 

 

7. [ENTER] / [Store] 

 

 

Example: 

In this example we will move Group 1-5 to Group 8: 

1. [SHIFT + Move] 

2. Press [Group, 1 → 5] 

The command line will indicate the following: 

 

3. Press the [@] key.  

The command line will indicate the following: 

 

4. Enter target number 8. 

5. Press [Store] / [ENTER] 

The command line will indicate the following: 
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The above image shows that the group range 1 -5 was moved to group range 8-12. 

  

 

NOTE: If an object already exists in the target place, a pop-up message will appear giving 

you the option to either overwrite the existing or Swap the existing: 

 

 

 

ATTENTION! By default the numeric object type is Cue.  

For example;  

If you have Qlist 1 on the Master PB, which has cues 1-5, as soon as you start the 

sequence [MOVE, 4], the system will know you are referring to cue 4 from Qlist 1. 
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To move an object using the soft keys 

Sequence 1 

1. [SHIFT + MOVE] 

2. Select or Tap on the object to move. 

3. Select or Tap on the target soft key.( If the SK is empty) 

-OR- 

4. Press @ 

5. Select or tap on any target soft key. 

 

Sequence 2 

1. Press and Hold down [SHIFT + MOVE] 

2. While holding down [SHIFT + MOVE] select the object to move. 

3. Release [SHIFT + MOVE] 

4. Select or Tap the target soft key. (any free or occupied soft key)  

-OR- 

Enter the target number on the keypad. 

 

5. Press [Store] 

-OR- 

 

[ENTER] / [Store] 

 

ATTENTION! Sequence 2 above will not work if you have Fixture 

selection. 

To overcome this problem, press [SHIFT+ ●], before 

using the sequence. 
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To move a range of objects using the soft keys 

Sequence 1 

1. [SHIFT + MOVE] 

2. Select or Tap on the objects to move. 

3. Select or Tap on the target soft key.(If the SK is empty) 

-OR- 

4. Press @ 

5. Select or tap on any target soft key. 

 

 

 Sequence 2 

6. Press and Hold down [SHIFT + MOVE] 

7. While holding down [SHIFT + MOVE] select the objects to move. 

8. Release [SHIFT + MOVE] 

9. Select or Tap the target soft key.  

-OR- 

Enter a target number from the keypad.  

 

10. Press [Store] 

-OR- 

 

[ENTER] / [Store] 

 

Note the following: 

 Holding down the Copy / Cut or Move key on the keypad, will disable the keypad 
until you release them. 

 The MOVE sequences are NOT valid for Fixture copying or playbacks. 

 The above sequences can be used with numeric or non-numeric ranges. 

 Objects will be pasted in order of selection. 

 On non-linear ranges, the gaps will be kept after pasting to the target range. 
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The Copy Cue + Properties Button 

In tracking mode, we added another option to the Copy Cue dialog: 

 

 

By using this new option you are able to copy the Cue together with the cue properties(time, 

Delay etc.). This is the Default option. 

 



Effects Editor Improvements  

     | 26 

Effects Editor Improvements 

The following improvements were added to the Effects Editor: 

 Assign a value using the keypad at any time 

 Assign a negative value using the keypad 

 The Release button has been enhanced 

 Ability to run a Pre-Built effect on parameters of the same type example; RGB 

 

Assign a value using the keypad 

When using the Effect Editor, you are now able to assign an exact value using the numbers 

keypad. The value will be assigned immediately once entered. The system will now also accept a 

single digit number such as “1”. 

If you have entered a value and you decide to change that value completely, then you will need 

to do either of the following before entering a new value: 

 Press on the Effect attribute button you are working on, example; Rate → All 

-OR- 

 Press on the parameter key associated with the effect you are working on.(The keys 

above the Parameter wheels on Vector Red or Vector Blue) 

You are now also able to enter a negative value for Size and Rate using the “-“key. 

[- Key, #], Example; -50 

 

Note the Max values for the following: 
 

 Offset; 100% 

 Size; 100% -OR- -100% 

 Rate; 327 sec –OR- -327 sec 

 Duty Cycle; 255 

  

 

     Tips!  

 Instead of using the Keypad for Full, On or Zero values, press the FULL or 

ON/ZERO keys. 

 You can also use the negative “-“key with the FULL or ON/ZERO keys.  

For example; [- Key, FULL] 
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The Enhanced Release Button  

The enhanced Release option which has now also been added to the advanced tab can now be 

used in 2 ways: 

 When an effect is running, click on the Release button once to release a Primitive 

selection, click again to reset the other effect attributes. (Offset, Size, Rate, Duty cycle) 

 If NO Primitive is selected, click once to reset the Effect attributes. 

  

ATTENTION! If you release a Primitive only (One Click), then close and re-

open the Effect Editor, the Effect attributes will be reset. 

  

NOTE: You can also use the [RELEASE] key on the console panel to perform 

the above operations when the effect machine is open. 

 

 

 

 

 

 

 

Release Button 

Effect Attributes 

Effect Primitives 
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Run a Pre-Built effect on parameters of the same type 

An effect will now run on all parameters from the same type. This can only be done when using 

effects from the Pre-Built tab. 

Example 1: 

If you have 10 (Color kinetics), ColorBlaze-72 fixtures: 

[Fixture, 1->10, EFFECT, RAINBOW] 

The effect will now run on all the 12 sets of RGB parameters. 

 

Example 2: 

If you have 10 (Studio Due), CS-4 fixtures: 

[Fixture, 1->10, EFFECT, DIMMER FADE] 

The effect will now run on all the dimmer parameters of that fixture (4 Dimmers). 
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Direct PB Operations 

You are now able to perform PB operations, for example; assign Qlists, release PB’s etc., 

directly from the PB wing view by using the option “Interactive Selection”. This option is 

located in the View menu and can also be used to enable or disable the feature for every PB view.  

 

Using Interactive Selection 

When Interactive Selection is enabled a divider will be placed on the PB and Q-Key wing view: 

 

 

 

To turn ON Interactive Selection 

 From the View menu select Interactive Selection. 

 

Once Interactive Selection is enabled, then the section above the divider line will behave like the 

Select keys of the playbacks. This means that all operations that are done using the Select keys 

can now be done from the PB wing view. By clicking on the section below the divider line will 

open the Cue sheet for that PB. See Viewing the Cue sheet 

 

 

Tip! You can use the PB control keys to manipulate the PB, (PB release, Free, GO, Forward or 

Backwords, take Priority, Etc…) 

 

Interactive Selection OFF Interactive Selection ON with divider 

Use this section to assign Qlists, 

Release PBs, etc. 

Click here to open the Cue sheet 
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Example: 

If Interactive Selection is enabled and you want to store Qlist 1 on PB 1, then instead of using 

the Select key PB 1, click on the top section of PB 1 in the PB wing. 

Type Qlist 1 and tap or click on the Playback wing: 

  

 

 

 

 

 

 

Viewing the Cue sheet 

You can view a Cue sheet of a PB by simply clicking on the section under the divider line. From 

the Cue Sheet, you can also view the PB, Exam and Preview by clicking on those tabs. The Cue 

sheet now has 2 new buttons on the right hand side for easier navigation- A back button and PB 

Setup button: 

 

 

The PB Setup option is also available on the pane title bar of any specific PB view including A/B 

and Master PB Views: 

 

Click here to add Qlist 1 to PB 1 

Qlist 1 has been added to PB 1 

The Back button will take you back to the PB 

wing view. 

The PB Setup button will open the PB 

properties dialog. 

Pane Title 

Right hand side options 
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Inside a specific PB view, the PB tab is also intercative and can be used instead of using the PB 

select key. This includes A/B and Master PB views: 

 

 

ATTENTION! By default the Interactive Selection is enabled, even when loading a layout 

from a previous version (3.18). 

 
Note the following: 

 

 The Right hand side options (Back button and PB Setup) are not available on 

A/B and Master PB views. 

 The Interactive PB operations will work on PB’s and in Qkeys views. 

 The console will divide the PB view regardless of the fields order. 
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Vector Snap Enhancement 

A new button has been added to the System Settings ► Playback tab under the Snap Options 

called “Activate Snap On Load”. The “Activate Snap On Load” enables you to choose what 

happens to the snap when you load a show. When the option is enabled, the snap will load as it 

does at the moment. When the option is disabled, the snaps will be loaded forcing all PB’s to be 

released. 

 

 

The behavior of the “Activate Snap On Load” is saved in the Show Data, (Meaning, when 

loading a show, the console will check the state of this option and then load the show 

accordingly). Therefore, before saving a show you will need to decide how you want the snap to 

behave when loading that show. 

Example: 

1. Store a Cue on a PB. Make sure the PB is activated. Save as Snap 1.  

2. Enable “Activate Snap On Load”. Save the show as “Snap Active”. 

3. Disable “Activate Snap On Load”. Save the show as “ Snap Released” 

4. Load a new show to clear all the data. 

5. Load the saved shows and notice what happens: 

Activate Snap On Load - Enabled:      Activate Snap On Load - Disabled: 
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ATTENTION! Old and new shows will be loaded to the default setting of 

“Activate Snap On Load” disabled. 

 

Tip! Load your old shows, and then re-save them using the “Activate Snap On 

Load” feature. 

 

 Note the following:  

 Warm Data has no relation to the “Activate Snap On Load” option. Warm 

Data will continue working as it does today. 

 The Snap will remember which PB’s are enabled, but when loading the show 

this data will be ignored. 
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The Apply & Continue Option in the Wizard 

The Wizard that is used to Create & Patch Fixtures, Patch Fixtures, Modify Fixture Ranges, and 

Modify Dimmer Ranges has been enhanced with a new button called “Apply & Continue”. 

This button enables you to apply the change and continue working in the same wizard dialog 

without re-opening the Wizard after every operation. The “Finish” button is still a valid 

operation that can be used once you are satisfied with your changes. 

 

Using the Apply & Continue button 

When opening a wizard the Apply & Continue button will be greyed out until you have made 

your additions or changes and have moved to the next screen using the Next button: 

 

 

  

Apply And 
Continue 

button 

NOTE: The Help 
button is now 
move to the top 
right of the dialog 
box. 
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Tapping on the Apply & Continue button will apply the changes, and then the wizard will return 

to the previous screen thereby enabling you to add more devices or fixtures. When you are 

satisfied with your additions, tap the Finish button to close the wizard. 

Every time you use the Apply & Continue button, the system will automatically generate the 

next available number for that device. For example; if you modify a range for spots 1-9, then you 

use Apply & Continue, the next range will start from the next available number, i.e. spot 10. 

 

NOTE: The Help button is now at the top right corner.  

 

Modify and Patch Information Improvement 

Now when you Modify or Patch dimmers in the patch manager, the range selected will be shown 

in the Title of the dialog. This applies to the following: 

 Creating and Patching Fixtures 

 Patching Fixtures 

 Modifying Fixture Ranges 

 Modifying Dimmer Ranges 

 

 

Apply And 
Continue 
button 
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SMPTE, MTC, MIDI Enable / Disable 

You now have the ability to control the signals from SMPTE, MTC, MIDI In and MIDI Out. 

This enables you to turn OFF one or more of these protocols. 

 

New buttons have been added to the System Settings ► MIDI/SMPTE tab: 

 

 

The MIDI Input, Output and Macro buttons are greyed out until the main MIDI button is 

activated. 

 

 

NOTE: When MTC is enabled, the console will listen for MIDI time code protocol 

regardless if the main MIDI button is enabled or not. 

 

 

 

New added buttons 

Main MIDI button 
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A new “MIDI/SMPTE” Soft Key option has also been added to the Setup Toolbar. This is 

accessed by pressing the Setup key on the actual console: 

 

 

By pressing the MIDI/SMPTE soft key will open a new MIDI/SMPTE toolbar: 

 

 

 

 

Tip! You can create a Macro to trigger the options in the MIDI/SMPTE Toolbar.  

 

The MIDI/SMPTE new buttons 

The following is a list of the new MIDI/SMPTE buttons with their functions: 

Button Function 

MIDI Input Keys Enable this key together with the main MIDI button to receive MIDI 
commands into the console. 

MIDI Output Keys Enable this key together with the main MIDI button to send MIDI 
commands from the console. 

MTC Enable this key to receive MIDI Time Code protocol (External Timeline 
Clock) into the console. 

SMPTE Enable this key to receive SMPTE protocol (External Timeline Clock) into 
the console. 

 

 

 

 

 

 

 

Main MIDI SK 
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Using MIDI/SMPTE System Settings Tab 

After pressing on the main MIDI button, the MIDI Input, Output and Macro keys will become 

available: 

 

 

Once the main MIDI key is activated, and you have clicked on OK or Apply; The Indication bar 

will display MIDI: 

 

 

After selecting a MIDI key choice; MIDI Input Keys, MIDI Output Keys, or MIDI Macro, the 

changes will NOT be immediate until you apply the change by pressing OK or Apply.  

Once you have applied the change, it will be visible on the Indication bar and on the 

MIDI/SMPTE Toolbar. 
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Example: 

MIDI, MIDI Input and MIDI Output keys have been selected: 

 

 

After you press Apply, the Indication bar will display “MIDI I/O”(MIDI Input / MIDI Output): 

 

 

Indication bar MIDI/SMPTE indications 

The following is a list of MIDI/SMPTE indications on the Indication bar: 

MIDI 
Indications 

Activated key’s SMPTE / 
MTC 
Indications 

Activated key’s 

 Main MIDI Only or 
main MIDI + MIDI 
Marco 

 SMPTE  

 Main MIDI + MIDI 
Input keys 

 MIDI Time Code (MTC) 

 Main MIDI + MIDI 
Output keys 

 MIDI Time Code (MTC) + 
SMPTE 

 Main MIDI + MIDI 
Input keys & MIDI 
Output keys 

  

Selected 

MIDI keys 
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Using the MIDI/SMPTE Toolbar 

The MIDI/SMPTE Toolbar is accessed by pressing the Setup key ► MIDI/SMPTE Soft key: 

 

 

When using the MIDI/SMPTE Toolbar, by pressing on any of the MIDI commands (MIDI Input, 

MIDI Output, MIDI Macro), will automatically activate the main MIDI key. After selecting an 

option from the MIDI/SMPTE Toolbar, Store (Action Mode) or ENTER/Store (Enter Mode) 

needs to be pressed to assign the command. Once the MIDI/SMPTE command is assigned, the 

Command line will display Assigned and the Indication bar will display the assigned MIDI or 

SMPTE command. 

The Assigned command will also be visible in the MIDI/SMPTE System Settings tab. 

Example: 

MIDI Output is enabled: 

 

 

After the MIDI/SMPTE command is stored, the Command line will display Assigned with the 

Indication bar displaying the assigned command: 

 

 

NOTE: The MIDI/SMPTE Toolbar will return back to the Default Tool bar after 

assigning the command. 

The Command line 

displaying the activated 

MIDI command 
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ATTENTION! SMPTE and MTC new buttons are disabled by default, so any external 

trigger (SMPTE or MIDI Time Code) will be ignored unless you enable the relevant 

SMPTE or MIDI Time Code button. This is relevant for new shows and saved shows 

from previous software versions.  

 

The SMPTE / MTC TimeLine Clock 

A new Clock tab has been added to the active TimeLine view screen. This clock is a reflection of 

the Indication bar TimeLine clock. The Clock can be resized by changing the tab size. 

 

The active TimeLine clock is for preview only and cannot be edited. 

 

 

 

 

 

Note the following color changes: 

(This also applies to the SMPTE / MTC Clock on the indication bar)  

 The Clock color will be Orange when SMPTE is running from the internal 

clock. (TimeLine Toolbar ► RUN) 

 When running from an external clock, the clock color will be according to the 

console theme. 

 

SMPTE / MTC 

Clock View on 

the Indication 

bar 

Hours Minutes Seconds Frames 
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Desktop Enhancements                                                          

The new desktop enhancements enable you to do the following: 

 Add stage elements in various shapes 

 Define, lock, display or hide elements using the Layers Toolbar 

 Group elements 

 Drag shortcuts from the Window explorer to the desktop  

 Undo last changes 

 Print the desktop 

 

With these enhancements come two new Toolbars; The Stage Elements Toolbar and the Layers 

Toolbar. These are floating Toolbars which can be positioned anywhere on the screen. 

The Toolbars are accessed from two new buttons located on the Desktop pane title: 

 

 

 

 

NOTE: Unlock   the display before editing anything on the desktop. When finished, 

be sure to lock the display.   

 

The Stage Elements Toolbar 

The Stage Elements Toolbar contains 16 pre-defined elements that can be dragged onto the 

Desktop. Once an element has been dragged to the desktop, then you can manipulate them to 

change size, angel, shape, line thickness and line color.    

Stage Elements Toolbar: 

 

 

 

 

 

Layers Toolbar 

button 

Stage Elements Toolbar NOTE: The Grid button has also 

been added to the Desktop pane title. 

Vertical 

Line 

Curve Square 

Rectangle 

Polygon 

Triangle 
Open Circle 

Open 

Polygon 

Open Triangle Open Square L-Shape 

Hoist 
Truss 

Circle Arrow Horizontal 

Line 
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To add stage elements to the Desktop 

1. Add a Desktop to your show.(Right click and select Add Desktop) 

2. From the Desktop pane title click on the Stage Elements button: 

 

The Stage Elements Toolbar will appear: 

3. Using the mouse, drag the desired element onto the Desktop area. 

The Element will appear on the Desktop like the following example which is a circle: 

 

 

 

To name the element 

1. Double click the Name field.  

-OR- 

Click on the actual element to select it, and then Right click, select Rename from the 

menu.  

2. Type desired name in the Name field. 

3. Press Enter or click anywhere in the desktop area. 
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To move an element 

1. Click on the actual element to select it. 

-OR- 

Highlight the Element/s by left clicking the mouse and dragging the highlighter over 

the Element/s. 

-OR- 

Select a few elements using CTRL and left mouse click. 

2. Once the Element is selected, left click on the actual element, hold the mouse key 

down and move the Element to the desired location. 

You can also move the Element by clicking on the Name field and dragging the 

mouse. 

 

To change element size 

 Click and drag one of the white points from the outside frame: 

 

 

 
Tips!  

 To change the size of multiple elements, select the elements, and then 

drag one of the points from the outside frame. 

 To equally change the size of an element; press and hold SHIFT while 

stretching the element. 

 

 

 

 

 

 

The Arrows icon will appear once 

the mouse is over a stretch point.  
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To rotate the element 

Click and drag the rotation handle (Green point) at the top of the Element in the direction 

that you want to rotate. 

OR 

Right click ► Rotate. 

 

 
Tips!  

 To rotate multiple elements, select the elements, and then drag the 

rotate point of one of the elements. 

 By holding SHIFT together with the mouse, you can rotate the 

element in jumps of 18 degrees. 

 

To change the element shape 

Click and drag one of the points on the actual element (Red points): 

 

 

Tip! By holding SHIFT together with the mouse, you can drag the element from 

the red points in a straight line. 

 

The Rotate icon will appear once the 

mouse is over the rotate point.  

The Red Arrows will appear once the 

mouse is over a draggable point.  
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To add points to an element 

You can add more points (Red only) to an element if needed; Min 2, Max 16 points. 

1. Select the stage element. 

2. Place the mouse on the element line where you want to add a point. 

3. Right click and select Add Point. 

 

To remove a point 

1. Place the mouse on the red point you want to remove. 

2. Right click and select Remove Point. 

 

To delete an element 

1. Click on the actual element to select it. 

-OR- 

Highlight the Element/s by left clicking the mouse and dragging the highlighter over 

the Element/s. 

2. Press Delete. 

-OR- 

Right click ► Delete 

-OR- 

Press Delete on the keyboard. 

A Delete Objects dialog will appear: 

 

3. Click Delete to delete the Element or Cancel. 
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To print a desktop 

You are now able to print the desktop. 

1. Open the Desktop view 

2. Click on the Desktop view tab to activate it for printing. 

The selected desktop view should have an orange frame around it. 

3. From the File menu select Print. 

-OR- 

Ctrl + P 

 

NOTE: The Desktop will not print using the “Print Multiple” option. 

Using Undo 

The Undo command can be used to undo the following: 

 Undo Movement of an object. 

 Undo a deleted object. (When using undo to restore a shortcut, the shortcut will be 

restored with a generic icon) 

 Undo an “Add/Remove” object from the user defined layer. 

 Undo Rotation, Stretch and drag. 

 Undo for group or ungroup. 

 

To undo 

1. Place the mouse anywhere in the Desktop. 

2. Right click, select Undo. 

 

NOTE: You only have 1 Undo.  
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Stage Element properties 

In the Stage Element Properties you can change line thickness, angel, color, and style, name the 

Element and decide if you want the Element to be open or closed, curved or not curved.  

 

To access stage element properties 

1. Right click on the element. 

2. Select Properties. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Stage Element properties 

  49 |  
 

The Stage Element Properties window 

 

 

Stage Element properties options 

The following is an explanation of the Stage Element Properties options: 

 Name: Name of the Element. Click in the Name field to change the name. 

 Location: The X and Y points enable you to place the element in the exact location. 

 Layer: Use the Layer drop down menu to add the element to a layer. See The Layers Toolbar  

 Thickness: Changes the thickness of the Element line; Min value is 0. Max value is 255.  

 Angle: Changes the Angle of the Element. 0 - 360Deg  

 Style: Allows you to change the Style of line, for example; Dotted line………. 

 

NOTE: In order to use the Styles, the Curved Element button must be disabled. See 
number 9 below. 

Tip! You can also change any element into a “Truss” style by selecting Truss from the 
Style pull down menu and increasing the Thickness of the line. 

1 

4 

5 

6 

7 

8 9 

2 

10 

3 

1 

2 

3 

4 

5 

11 12

2 

6 
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 Color: Changes color of the Element line. 

 Close Element: If the button is enabled the Element shape will be closed. If the button is disabled 
the Element shape will be open. 

Example:  

In this example we will use the Circle Element. 

 

Closed Element:          Open Element: 

 

 

 

 

 

Tip! If you have an open element, for example; Open Square, you can close the Square 
by clicking the on the Close Element button.  

 

 

 

 Curve Element: The Curve Element button is used to Curve or un-curve the Element. 

Example:  

In this Example we will use the Square Element. 

 

Curve Element button is disabled:                         

 

 

 

 

 

 

 

 

 

7 

8 

Curve Element button enabled: The 
Square now becomes a sort of circle: 

 

9 

8 
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 Reset Buttons: By clicking on the Reset button will reset the individual function back to the last 
saved value.  

 Show: Show or hide element name. 

 Center: Centers the Element name or places the name outside the Element. 

 

 

NOTE: The changes to the object will be saved only if you close the dialog by 

clicking on OK or Apply. 

 

Tips! 
 

 You can change the stage properties of multiple elements by selecting the elements 
then selecting properties. 

 You can preview the changes on the actual element.  

 

The Layers Toolbar 

The Layers Toolbar gives you the option to display the Elements on the Desktop or not. You can 

also define layers, lock layers and decide which layers you want to display. 

A Layers Toolbar button will only become active once you add a relevant object to the Desktop. 

 

Layers Toolbar: 

 

 

 

 

 

 

 

 

 

 

 

Shortcuts 

Layer 
Topo 

Shortcuts 

Layers 

Stage 

Elements 

Layer 
Groups 

Layer 

User Defined Layers with Lock Layers 

10 

11 

12 

Show / 

Hide 

Text 

Show / Hide objects 

that are not 

attached to any 

user defined layer 
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The Layers Toolbar options 

The following is an explanation of the Layers Toolbar options: 

Layers Toolbar 
Option 

What is does… 

 

This option will show or hide all text on the desktop. 

When Enabled: 

Object text will be visible on the desktop ( According to the object 

properties) 

When Disabled: 

All object text will be hidden. 

 

This option will show or hide all shortcut objects on the desktop, (except 

Topo shortcuts) 

When Enabled: 

All shortcut objects will be visible. 

When Disabled: 

All shortcut objects will be hidden. 

 

This option will show or hide all shortcut objects added from the Topo 

view. 

When Enabled: 

All Topo shortcut objects will be visible. 

When Disabled: 

All Topo shortcut objects will be hidden. 

 

This option will show or hide Stage elements on the desktop. 

When Enabled: 

All Stage element objects will be visible. 

When Disabled: 

All Stage element objects will be hidden. 

 
This option will show or hide grouped objects on the desktop. 

When Enabled: 

All grouped objects will be visible. 

When Disabled: 

All grouped objects will be hidden. 
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These options are user defined layers, of which there are 5 to work with. 

When the Layer is Enabled: 

All the objects in the layer will be visible. 

When the Layer is Disabled: 

All the objects in the Layer will be hidden. 

 

Locked or Un-Locked Layers 

When a layer is locked, you will not be able to select or manipulate the 

objects in it. The layers lock can only be used when the Vector display is 

Unlocked :  

When the Layer is Locked: 

The Objects in the layer will be visible but they cannot be manipulated. 

When the Layer is Un-Locked: 

The Objects in the layer will be visible and can be manipulated. 

 
This option will show or hide objects that are NOT linked to a user defined 

layer. 

When Enabled: 

All the objects that are not linked to a user defined layer will be visible. 

When Disabled: 

All the objects that are not linked to a user defined layer will be hidden. 

  

 

NOTE: When an object is part of a user defined layer, the object will still be part of its 

generic layer. Therefore both of the layers must be visible in order for the object to be 

visible. 

Example: 

If you add a shortcut to the desktop, it is automatically part of the Generic shortcut 

layer. 

If you add that shortcut into a user defined layer; example user defined layer 1, the 

object will then part of both layers.(Generic shortcut layer and User defined layer 1) 

In order to see this object, both layers must be enabled. 
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To add objects to a user defined layer 

Any desktop object can be added to a user defined layer. 

1. Select the objects to add. 

2. Place the mouse on the selected objects. 

3. Right click. 

4. From the User Defined Layers list select a layer from 1-5. 

 

-OR- 

Right click on the Object ► Properties ► Layer 

Once you have selected a User Defined Layer, the User Defined button on the Layers 

Toolbar will become active: 

 

 

To hide objects in a layer 

 Click on the active User Defined Layer. 

 

To lock objects in a layer 

 Click on the lock button 

 

To remove objects from a layer 

1. Make sure the layer is unlocked. 

2. Select the objects to remove. 

3. Place the mouse on the selected element. 

4. Right click. 

5. From the User Defined Layers list select None. 
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To hide text on all objects on the desktop 

 From the Layers Toolbar click on the Text button  

This will hide all text from all objects. 

 

To hide text on selected objects on the desktop 

 To hide text from a selected object, Right click on the object and select Show/Hide 

Text. 

 

 

 

Groups 

Grouping is when you take a bunch of objects and put them into one group. You can have many 

groups each with a bunch of objects. Any desktop object can be grouped. 

Note the following on groups: 

 A group can also be part of a user defined layer. 

 Objects in a group cannot be selected or manipulated separately.  

 Object options such as rename, properties, rotate etc. will be greyed out when the 

object is in a group. 

 Objects that are part of a user defined layer or any other generic layer will be cleared 

from those layers after grouping.(These objects will now be part of the Groups layer) 

 Groups can be combined together by selecting both the groups (Right click ► Group) 

 An object in a group will belong to the Groups Layer until ungrouped. 

 When you group objects, there unique properties will be kept (Show/Hide Text, 

Color, thickness etc.) 
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To group objects 

1. Select the objects to group. 

2. Place the mouse on the actual element. 

3. Right click, select Group. 

The Groups Layer button  will become enabled and there will be white broken 

lines around the group. These broken lines will become a dark grey color once you 

click on another object. 

 

 

To ungroup objects 

1. Select the group to ungroup. 

2. Place the mouse on the selected group. 

3. Right click, select Ungroup. 

 

To undo 

See Using Undo 
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Drag Files from PC Desktop to Vector Desktop 

Shortcuts from the Window explorer can be dragged to the desktop (Except windows 

components, such as “My Computer, My Networks, etc.) 

 

To drag files to the desktop 

 Simply drag the Shortcut from the Window explorer to the Vector desktop: 

 

 

 

NOTE: The shortcuts are LINKS only. These files will not be saved in the 

show, only the links will be saved.  

 

Tips! Dragging files to the Vector Desktop can be usefull for: 

 Quick access to run applications such as C-Net Manager. 

 CAD drawing of your stage or bitmap. 
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The Shortcuts properties dialog 

The Shortcuts properties dialog is used to edit properties of a shortcut object. 

You can perform the following: 

 Change the name of the Shortcut 

 Show / Hide the Shortcut text 

 Enter an exact location to place the shortcut using X and Y fields 

 Add the Shortcut to a user defined layer 

 Add a hotkey for the shortcut  
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Using the Grid 

The Grid Show / Hide button , which is located on the desktop title pane, adds layers of dots 

that can be used to align objects. This grid works the same as the grid on the Topo.  

 

General Desktop Notes 

The following are general notes on using the Desktop enhancements: 

 To select an object click once, then click again to move the object. 

 When moving an object red point the frame will reset. 

 When printing a desktop the zoom may change. 
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Export Show to ASCII 

You are now able to export channel information, groups and 1 single Qlist (According to the 

standard protocol) to an ASCII show file. The console will not allow you to export unless you 

have at least 1 channel and 1 Qlist. 

When exporting an ASCII show file, the following data is exported: 

 Cue data 

 Group data 

 Cue time data (time-in / time-out) 

 Cue Link 

 Patch 

 Proportional patch level  

 Text of the Cue or Group 

 

NOTE: A group will not appear in the Export to ASCII Show dialog if it does not 

contain any channel data.  

 

To export a show to ASCII 

Before you export a show to ASCII make sure you have a channel and a Qlist in the show. 

1. From the File menu select Import/Export Shows ► Export Show To ASCII. 

 

2. From the Export to ASCII show dialog select the objects to export: 
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3. Click Export. 

4. Select the destination to save the file. 

5. Type the file name, select Save. 

The file will be saved with the extension:.asc  

 

ATTENTION! If more than 1 Qlist is selected, the console will merge these Qlists 

into 1 Qlist. This will cause the cues to be re-numbered. 

 

NOTE: Import ASCII show file now supports; Proportional Patch and Cue Link.  
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More General Enhancements 

The following pages contain explanations on more general enhancements. 

 

WIN SCROLL Enhancements 

The following are new supported keyboard keys in WIN SCROLL mode: 

Pressed PC Panel key Will act as Keyboard key 

[MACRO] ALT 

[SNAP] Space 

[UNDO] UNDO ( CTRL + z) 

[COPY] COPY (CTRL + c) 

[PASTE] PASTE (CTRL + v) 

[ACTIVE] SELECT ALL (CTRL + a) 

 

 
Tip! By using [MACRO] + → (Thru) in WIN SCROLL mode will give you the 

same effect as Alt + Tab on the windows keyboard. 

 
NOTE: When you open a Text dialog or the Matrix ► Fixture properties, the WIN 

SCROLL will turn ON automatically.  

The WIN SCROLL will automatically turn OFF when you exit the Text dialog 

or Matrix ► Fixture properties. 

 

Locked Columns Enhancement 

Now when you lock columns there will be a thicker and brighter line. This line will take the 

colors according to the grid colors: 

 

Thicker and brighter line 

when columns are 

locked 
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Blind Enhancement 

By using the following sequence you can copy the editor values into the Blind editor. This can be 

done even if the Blind editor already has values. 

 

To copy current editor values into the blind editor 

This sequence will copy the editor values into the blind editor and will automatically enter 

the blind editor: 

 [SHIFT+BLIND]  

 

Import Devices Improvement 

By using CTRL or SHIFT together with the mouse (as you would do in windows), will enable 

you to select multiple devices in the Import device tree. 

 

Import / Export Shows Enhanced Menu 

All Import and Export options have been added into one menu: 

 

 

ATTENTION! The previous way of importing 4D / Sabre / ASCII shows by using File 

► Open Show is NO longer valid. 
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Workspace Improvement  

When you have only one workspace in a window, there will be no workspace indication tab until 

you add another workspace:  

 

 

To add a workspace 

1. Right click anywhere. 

2. Select Add Workspace. 

The Workspace indication tab will appear and will show both workspaces. 

 

 

 

 

 

 

 

 

 

 

 

No workspace indication tab 
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Using PB in Cut Time 

You are now able to manipulate PB content by using the [SHIFT] key together with a PB key. 

The following are PB key behaviors:  

Key Behavior  With SHIFT Without SHIFT 

GO PB will fade in using Cut 

Time. 

PB will fade in using Cue 

Time. 

GO / RELEASE PB will act as ON / OFF PB will fade in using Cue time 

or will be released using 

release Time. 

RELEASE PB will be released in Cut 

time 

PB will be released in release  

time 

BACK / HOLD or BACK PB will fade back in Cut 

Time. 

PB will fade back using back 

time. 

ON / OFF PB will act as GO / RELEASE PB will fade in/ out using Cut 

Time. 

 

NOTE: The above behavior will work with PB’s and Q-keys. 

 

 

Quick access to MARCO’s 111 – 116 

You are now able to use MARCO’s 111 – 116 directly from the 6 original MARCO keys on the 

panel. You can do this by pressing [SHIFT], then pressing on a relevant MACRO key. 

MARCO Key Key + SHIFT MARCO Key Key + SHIFT 

 macro 101  macro 111  macro 104  macro 114 

 macro 102  macro 112  macro 105  macro 115 

 macro 103  macro 113  macro 106  macro 116 
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